This is a list of recent email communications. We aim to send out frequent updates on the status of
the redesign project as well as inform of recent accomplishments and any known issues. If you are not
on our insurance industry email distribution list and would like to be, please email
FRRedesign@flhsmv.gov and request to be added.

09/11/2014:

Our daily process has resumed. If you received any unknown errors on Monday, please resubmit the file.
If you receive any unexpected errors off from our run that happened tonight, please do the following:

1) email Tiffany Moyal, Laura Freeman, FRRedesign and myself (all copied above)

2) include unencrypted output file

3) include account name

4) include brief description of issue

If you submitted multiple flat files, please keep in mind that your output may be combined. We thank
you again for your patience these past few days.

09/09/2014:

| apologize for the delay. Our daily processing is still turned off. Therefore, you will not be receiving any
output files until resumed. We will keep you informed of any progress. We apologize for any
inconvenience.

09/08/2014:
Some insurance companies will be receiving duplicate output files for the same daily file. We are re-
running a process internally. The first file (earliest date/timestamp) contains your real errors that you

will need to correct. Please ignore the second output file.

Additionally, we had to stop our daily processing. Therefore, not all flat files got processed before the
4:00pm EST scheduled pick up time. All XML files were processed.

All processes should be caught up and running as expected tomorrow.

08/26/2014:

Tomorrow, August 27, 2014, we will be deploying two fixes to correct known production issues.

The first change will be to correct issues with the unregistered VIN files that are flagging certain FL
registered vehicles as not being registered in our state. Please let us know if you have any issues with

the unregistered VIN files received after Thursday. You can verify if a vehicle is a valid FL registered VIN
by using our online tool located at https://services.flhsmv.gov/MVCheckWeb/.

The second change is to correct the name structure in the new daily C files to match the weekly C files.
We will be working on a data conversion to correct old data. Therefore, for a few days, it is possible that
you will see both formats (some old data with bad formatting and some new data with the corrected
format). We anticipate the data conversion to be completed within a week. Please let us know if you
have any issues with the newly deployed daily C files.



08/18/2014:

On Friday 8/15/2014, our Secure File Transfer Protocol (SFTP) server was shut down and you were
advised not send any files (daily files, reload files, test files, etc) until you hear from us. Our changes over
the weekend were successful and the server is running as normal. Please resume sending your files as
usual.

08/13/2014:

On Friday 8/15/2014, our Secure File Transfer Protocol (SFTP) server will be shut down between 5:00-
6:00pm EST. Please be aware that during this timeframe, you will not have any connectivity to the
server. In addition, we ask that you do not send any files (daily files, reload files, test files, etc) until you
hear from us on Monday 08/18/2014.

06/17/2014:

Due to several internal issues, your output files for today will be delayed. Many of you will receive
output late this afternoon. The rest can expect output returned tomorrow (combined if in flat format).
Please let your members know.

04/30/2014:

Please see the attached memo concerning Florida insurance reporting requirements and its effect on
our mutual customers.

Also, as a reminder, our XML transaction report changes will be deployed on Monday May 5, 2014.
Please refer to the memo dated March 4, 2014 for further information:
http://www.flhsmv.gov/FRManualFTP/FloridaFRRedesignXMLTransactionReportChange2014-03-04.pdf

Please feel free to contact me at FRRedesign@flhsmv.gov with any questions or concerns.

04/10/2014:

The weekly Monday verification process will continue running while the new daily verification process is
off. As a reminder, you are required to continue responding to these files within 20 days as required by
law. For the next few weeks, your weekly verification files will be larger than usual. Please try to work
within the required timeframe. If you have any issues with volume, please contact us so we can work
with you.

04/08/2014:

We have identified a system error which we are working diligently on correcting. As a result, we will be
deleting many cases against our mutual customers. In the meantime, we have put our registration
sanction creation on hold and will be holding verification files.



Please do not respond to any previous daily verification files for sanctions starting with 800000000
(SR_verifications_timestamp files). Once our data is cleaned up, we will be resending all remaining
needed verifications within 30 days. These verifications will be marked ‘L’ for late. However, we will not
hold these against anyone.

Please understand that this communication does not apply to the weekly verification files. You are
required to respond to all of these inquiries within 20 days.

In addition, we know many of you have experienced higher than usual call volume and customer
inquiries. In response, we have received a massive influx of emails, calls and faxes. We are working
diligently to respond as quickly as possible. However, please allow 2-3 business days for a response. As
previously mentioned, we are working on deleting many of these ‘problem sanctions’. If a customer
contacts you regarding one of these cases, please use our DL check site first located at
https://services.flhsmv.gov/DLCheck/. This site will advise if the customer has any open requirements
on their record. If there are no open sanctions, please do not email/call/fax us for clearance. The
customer can also use this site to confirm if their driving privilege is valid in the state of Florida.

Thank you all for your patience.

03/03/2014:

Many companies have reported not receiving their large Monday C file from last week. This would have
been the first weekly C file sent since the process was on hold. In an effort to ensure all companies have
this verification file, it will be resent tomorrow in our 8:00am EST job. The file should be ready by
8:30am and will have the standard weekly C file name (DHS.DDL.FTP.DMI...)

Please email FRRedesign with any questions.

02/13/2014 #2:

We have had several companies contact us concerning issues with their flat ‘B’ file output from
02/06/2014. In attempts to ensure everyone has their correct output file for that date, we will be
resending those files. If you received your 02/06/2014 output file and have no issues, you can ignore this
duplicate file.

Please contact FRRedesign with any questions.

02/13/2014 #1:

For XML customers, beginning today, the unregistered VIN holding errors will be returned in XML format
once again. You will no longer get a flat file with these errors. The file name will be

Unregistered_Vins_Timestamp.xml.

These errors do not apply to flat format customers. Please feel free to contact FRRedesign with any
questions or concerns.



01/24/2014:

The large Monday C file for 01/27/2014 and Daily C files will be delayed. You will receive your C files by
next Thursday. This will not affect regular daily processing. Please let me know if you have any
questions.

01/16/2014:

Our daily job will be resumed this morning. Processing may take several hours but output will be
returned today. For XML file, you should receive one file per file sent. For flat format files, your output
files will be returned combined. Up to 50,000 lines will be processed. If you files exceed this total, your
files will be broken down and returned multiple days until complete.

We appreciate your patience.
01/14/2014:

As advised on 01/10/2014, we have placed a temporary hold on insurance processing. This hold is still in
effect. We will continue to send out updates and inform as soon resolved. Thank you for your patience.

01/10/2014:

We have a hold on our insurance processing. You may not receive your expected return B file today. We
will advise once the insurance processing resumes. Sorry for any inconvenience. Please email me if you
have other questions.

12/31/2013:
Output for flat file insurance companies will be delayed. Instead of receiving your output this afternoon
as scheduled, you will receive your output Thursday morning. Your output will not be combined with

your regular Thursday output (which will be returned at the normal time).

This does not affect vendors, nor companies submitting in XML. In addition, please remember our
offices will be closed tomorrow.

Have a happy new year!

08/23/2013:

Our automated testing process is now deployed. Test files will be processed twice a day (9:30am EST
and 7:00pm EST). In order for the test files to be processed, all test files must be named according to

the email communication sent 06/24/2013. Capitalization does not matter:

1) Please begin all reload tests with ‘Reload_’
e Example: Reload_LaceyTest

2) Please begin all daily tests with ‘DailyLoad_’
e Example: DailyLoad_LaceyTest



These files must be placed in the TEST folder on the SFTP server. Output will automatically be returned
to your output folder on the SFTP server as soon as the test is done processing.

Have a great weekend!
08/06/2013:

Verification (C) files have been delayed this week. These files will be ran and available tomorrow
Wednesday August 7, 2013. You will receive the verification file tomorrow in your verification folder if
you have any verifications to report for this week.

06/24/2013:

As the testing process resumes, we would like to ask all of you to implement the following naming
conventions for your test files:

1) Please begin all reload tests with ‘Reload_’
e Example: Reload_LaceyTest

2) Please begin all daily tests with ‘DailyLoad_’
e Example: DailyLoad_LaceyTest

This process will allow for us to automate our testing process. In the near future, tests will not be
retrieved or ran unless named accordingly.

Please forward this email to anyone who may need these instructions. Please also remember to always
include your account name in the email subject line (XXXXFTP) so we can easily identify you to review
your account if necessary and address all Redesign concerns to FRRedesign@flhsmv.gov. When
reporting issues, please include your account name, a description of the issue including any screenshots,
and if you reported in flat file or XML.

Again, we thank you for your patience and assistance.
06/07/2013:

We are proud to announce that the redesign process has been running much smooth the past week and
we thank all of you for your assistance is making this possible.

Please continue to check our website for important information. We will be adding these email
communications to the site shortly. In addition, there are new versions of both the Daily and Reload
manual on the site for your review as well as new transaction report schema and the bulk policy errors
schemas. These changes include minor grammatically and format changes, additional information for
clarification purposes and the elimination of a few unnecessary error codes.

Previously, we have add issues with testing files. The testing process is now back up and running. We
will test XML daily files or reload files. When you are ready to test, please submit a test file to your test



folder and then email FRRedesign@flhsmv.gov. Please include your account name (XXXXFTP) in the
subject line and indicate if your test file is a daily or reload test.

We are continuing to experience issues with companies not receiving their verification files. If you have
not received a verification file (and you are suppose to), please email FRRedesign@flhsmv.gov with your
account name (XXXXFTP) and all of the FL Company Codes you report for under that account name.
Please make sure you are suppose to receive a C file (ie: it’s not going to a vendor who reports for you).

When you report an issue, please send to FRRedesign@flhsmv.gov with your account name (XXXXFTP) in
the subject line as well as if the file was a flat file or XML file. It will also be helpful to send dates, file
names and any other important information so we can research your request.

As always, thank you for your patience and assistance in working with us to make this project a success.

05/28/2013
Good afternoon,
We hope everyone had a fun and safe holiday weekend!

Effective Thursday May 23, 2013, our Department implemented programming changes concerning flat
format files. An unexpected issue concerning header records occurred.

It has come to our attention that companies who are submitting the NAIC codes rather than Florida
Company codes in their header record are encountering errors which are resulting in insurance
company code errors throughout their file.

We will be deploying a change effective tomorrow, May 29, 2013, to recognize the NAIC code in the
header record instead of returning the file with errors. This change will go into effect in the morning.
Additionally, we will hold all files tomorrow morning and run them after the changes have taken place.
Please resubmit any records for which these errors occurred.

Additionally, we have pushed the deadline to report in total XML and complete reloads to December 31,
2013. We are doing this in order to allow at least three months for you to program, test and implement
transaction types 12, 22, 26, 33, 36, 44 and 46. Once available, we will provide any schemas and

examples. This information, as well as the deadline, will be updated on our website.

We thank you for your patience and we apologize for any inconvenience.

5/23/2013



We are pleased to announce that our deployment for flat file errors went smoothly yesterday. Please
expect the changes in today’s error files (again, for flat format errors only). As stated in last Friday’s
status update, these errors will be similar to the old system errors. New XML errors and unregistered
VIN holding errors will not show as an error in the flat files. These files will still have the current naming
convention with the date/timestamp extension at the end. However, like the old system, you will
receive one output file. For companies submitting multiple flat files, you will only receive one file back.
This file will have the name of the file name of the last file processed with a date/timestamp at the end.

Example: if you submit flat files Lacey123 and Laura 123 in that order, your return file will be
Laural23(date/timestamp).

If you submit your file with NAIC Codes (in field positions 1-5) instead of your Florida Company Code
then you will continue to get your ‘Header’ record back with the converted Florida Company Code. All
of your ‘Filing’ records will remain with NAIC code. This is the only thing that we couldn’t change back
easily.

Once you have switched to XML, the new errors and holding errors will apply and we will want you to
perform an XML reload.

We will continue to accept either XML files or flat files. However, at this time, we still are not accepting
the following transaction types in XML: 12, 22, 26, 33, 36, 44, and 46. These should be sent in a flat file
(except 33 and 36 which are just not programmed yet). Also transactions 34 and 35 will not be accepted
in flat file format. We are looking forward to this change and hopefully hearing positive feedback
regarding the results. Please email FRRedesign@flhsmv.gov with any questions, concerns, or comments.
Be sure to include your account name (XXXXFTP) in the email subject line.

Below is a list of current known problems and updates:

Verifications:

Some companies are still not receiving verifications. We have found this to be the case for companies
who have a vendor report on their behalf but they still report maybe some of their transactions (such as
SR22/FR44s) and still do their own verifications. If this applies to you and you have not received a
verification C file since the server switch, please email FRRedesign@flhsmv.gov with your account name
and a list of the Florida Company Codes (Not NAIC codes) you report for. Be sure to include your account
name (XXXXFTP) in the email subject line. Please also remember that you will not always receive a C file
every week; these are generated only when there are verifications to report. Additionally, we have set
up an automated schedule to run these every Monday. Therefore, your C files should be ready Monday
afternoon to Tuesday at the latest. This service runs at 8am.

Validation Errors:

Many companies are experiencing errors when trying to validate with the XML schema. The Validation
Failed error file signifies that something is off in your format such as length, improper characters,
incorrect version number, etc. Below are the steps to validate a XML file. We ask for you to use this tool.
If you validate, but are still receiving validation errors from our system, we ask you to first send a
screenshot that your file validated successfully and then we will be able to further research the issue.

Steps to validate a XML file (Reload or Daily) against the XSD file




First, you will need an XML tool. The free tool we use here is Notepad ++. You can download it at:
http://notepad-plus-plus.org/ . Once installed, on the file menu, go to ‘Plugins’ > ‘Plugin Manager’ >
‘Show Plugin Manager’ and install ‘XML Tools’'.

1. Download the following file from http://www.flhsmv.gov/FRManualFTP/ :
‘FLBOB_Template_Reload _and_Daily Inputs.xsd’. Or if you are having issues downloading the
file, please request it to be emailed to you by contacting FRRedesign@flhsmv.gov

2. Open the XML tool, if you are using Notepad ++, on the File menu, go to ‘Plugins’ > ‘XML Tools’ >
‘Validate Now’. Browse to the location of the ‘FLBOB_Template_Reload_and_Daily Inputs.xsd’
file.

3. Click “OK” to validate.

You will either receive an “INFORMATION” window with your errors or a message stating your file
validated successfully. If you have errors, correct the errors and then re-validate your file. Repeat until
you receive the successful validation message.

Additionally, this information will be updated in the manual. As communicated in last Friday’s status
update, we are making several changes to the manual (such as providing more clarification and
examples), and a subsequent email will be sent once the changes are made. We encourage each of you
to view the manual once updated.

Missing Output:
We still have a few companies left with issues for missing B files. We have open service tickets for these
and are still working on them. We appreciate your patience with this matter.

Format Errors for Flat Files:

There are a few outstanding questions concerning flat file format errors. These should also be addressed
with the change effective today. However, if you have any issues, please email FRRedesign@flhsmv.gov.
Be sure to include your account name (XXXXFTP) in the email subject line.

XML Daily and Flat/XML Reload Testing Delays:

Many of you have contacted us about testing. We are still experiencing issues with our testing software.
It appears to be on our end and related to the decryption process. We are working diligently on a
resolution to these issues. Everyone who has submitted a test (and informed us so they were added to
the testing cue) will be processed in the order received as soon as possible.

Switch to Total XML:

Our current anticipated deadline is September 1, 2013. However, we are still working on the
programming of transaction types 12, 22, 26, 33, 36, 44 and 46. Once ready, we will provide examples
and schemas. We will allow at least 3 months upon receipt for you to program, test, and implement
XML. We will certainly send a memo at that time with an official deadline.

As a reminder, Monday is Memorial Day and state offices will be closed. We thank you all for your
assistance in making this project a success.

05/17/2013:



Good afternoon!
We would like to thank all of you for your assistance and your patience regarding our transitional phase.

As advised on Monday, we have been working all week towards a solution to alleviate concerns with flat
file error reporting. We know that many new errors were hard to interpret and we are confident we
have reached the best solution for both you and our mutual customers.

Wednesday night we will deploy changes that will affect flat format files only. These changes will be
effective on Thursday May 23, 2013. Although we are trying to build a more perfect system geared
towards XML, we realize not all processes were as smoothly implemented with the flat files as we had
hoped. We have worked very diligently this week to reinstate parts of the old system for your
convenience.

For all files submitted in flat format, you will receive one output file back. This output file will be similar
to the old output file where you receive a list of all the transactions submitted, and those with an ‘E’
indicator are the only ones with errors. These errors will be the same errors and same positions as you
were receiving in the old system. Additionally, we have eliminated the new error codes for flat files only
including the 30 day holding errors for unregistered VINs. The file naming convention, however, will
remain as it is currently with the date/timestamp extension at the end of your file name. Although old
business rules will be in place again (ie, sending multiple 20s for a policy), we would like to remind you
that all of the new rules and new errors will apply when you switch to XML format. We strongly urge you
to continue familiarizing yourself with these rules.

Additionally, we know many of you have concerns regarding previous ambiguous errors. We would
suggest that you resend these errors after the changes take effect. Your new errors will be in a form you
are accustomed to seeing. Additionally, we would strongly urge all of you to perform a reload once
converted to XML. This will help rectify any discrepancies with our database.

Again, those files submitted in XML will not be affected. If you submit in XML, you will continue to
receive output as you currently are with a separate file for all SR/FR transaction types and transaction

type 12s that are running through old coding.

Additionally, we are making several updates/clarifications to both our manuals. An email will be sent as
soon as the new manuals are posted.

We thank you again for your patience and participation in making this redesign a success.

05/13/2013:
Good afternoon,

We are pleased to announce much progress has been made in these past few weeks and we appreciate
all of your assistance in making this project a success.



We would like to share the following known issues:

Transaction errors:

We realize that there are some issues and concerns with interpreting new errors in the old format edit
mask. We strive to make this process as smooth as possible for you but know there will be hardships
along the way. Many of you have reached out with concerns in interpreting your errors for flat files
submitted. We have discussed several options and believe we can fix the problems by modifying the
new programming where it has to deal with the flat file. We are hoping to eliminate the errors that you
are receiving and were not expecting in the Flat File. | am very hopeful this can be done without other
issues being raised and fairly quickly, however, we are not able to make a final decision until late
Tuesday, so please be patient with us. If you are having trouble with new error, it is not necessary to
work them all right now, we will figure out a way to reprocess them or process another reload if
possible.

We will send out a correspondence detailing our changes later this week. We appreciate your patience
until then.

Verification Files:

Some companies have experienced issues with receiving ‘C’ files on the new server due to changing
account names. If you have not received a ‘C’ file since the switch, and expect to receive these
electronically, please forward your account name and the Florida Company Codes for each company you
report for in your account name.

Missing ‘B’ Files:
Some of you have contacted us about missing ‘B’ files. Please be patient with us. We are working to
recover these as quickly as possible and will advise as soon as resolved.

In addition, we have discovered that some companies are overwriting their files when submitting
multiple files. If you submit multiple files, please manually double check the server to ensure all files are
there. This seems to happen to more files that are the standard naming convention from the old system
where each file has the same name. We would suggest that you uniquely name your files to avoid this
error. For example, | could name my files Lacey05132013A and Lacey05132013B to avoid any confusion.
Just remember that a ‘B’ and a date/timestamp will be included at the end of all output files.

If you are missing output and you see those files you are missing output from are not in the archive
folder, it is possible that this issue pertains to you.

Please forward this email to anyone who may need to be included in this status. Please also remember
to always include your account name in the email subject line (XXXXFTP) so we can easily identify you
and review your account if necessary. Please address all Redesign concerns to FRRedesign@flhsmv.gov.

04/19/2013:



As you are well aware, we have switched entirely to our new server as of this past Monday, April 15™.
Please remember to use the appropriate folders when sending and receiving files.

We would like to share the following known issues:

Verification Files: As advised at the beginning of the week, there was an issue with the formatting of C
files and the date/time stamp extension being left off. These were re-ran last night and you should now
have a duplicate C file in your verifications folder. Please ignore if you had no issues with your first.
Header issue:

If you submit a NAIC code in your file, then our header will be modified to reflect your Florida company

code. If you do not know your Florida company code, then you can find it by visiting
http://www.floir.com/companysearch/.

‘B’ Return Files:

As a reminder, you will possibly receive a file for each process. One will come in the morning containing
all daily transactions (except the 30 as described below) and the other will be in the evening and contain
all transaction types running through the old coding format (22, 26, 33, 36, 44, 46 and now 30). These
files will have different date/time stamps that will distinguish them from one another.

For the morning process, you will receive back only errors. If no errors, you will receive an output file
with only a header and trailer.

You should receive errors as previously received in the old system for SR/FR/30 type transactions.
Missing ‘B’ Files:

Some of you have contacted us about missing ‘B’ files from the previous week. Please be patient with us.
We are working to recover these as quickly as possible.

Transaction errors:

‘30’ transaction: In the new system, a ‘30" will be used to change the effective date, level of coverage
(optional) or policy holder address. Please refer to the Daily manual located at our website for
information on how to change the name in the new system (XML format). In order to fix this error, for
all ‘30’ transactions sent in flat format, we will pull out all flat ‘30’ transactions and run through the old
system. This will therefore act the way it always has until you switch to XML. In the meantime, any
errors will be found on the SR/FR return file.

‘20’ transaction: In the new system, a ‘20’ is used to initiate a new policy only. Multiple 20’s should not
be sent for the same policy. You can handle this one of two ways:

e You can send a 20 and then add multiple vehicles.

e |f a 20 was already sent for the policy initiation, you would need to submit a 31.
*Please see page 11 of the daily manual for more clarification.



Level of Coverage error: This is optional. We have discovered that the if the company indicator was Y, it
was not set to default to 01. This has now been fixed.

Please forward this email to anyone who may need to be included in this status. Please also remember
to always include your account name in the email subject line (XXXXFTP) (even when replying to this
email!) and address all concerns to FRRedesign@flhsmv.gov.




